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Avid MediaCentral | UX Desktop

This document covers the introduction of the Avid MediaCentral UX Desktop application for
Windows. The following topics are included in this guide:

> System requirements
» Software installation

> Differences between MediaCentral UX Desktop and the MediaCentral UX web browser
experience

> Troubleshooting

Understanding the Desktop Application

In January of 2014, Google retired the Chrome Frame plugin for Microsoft Internet Explorer
which consequently retired support for MediaCentral UX on Internet Explorer. In September of
2015, version 45 of the Google Chrome browser will depreciate support for Netscape Plugin
Application Programming Interface (NPAPI) in favor of a newer architecture called Pepper
(PPAPI). This essentially eliminates support in Chrome for software such as Java, Microsoft
Silverlight and many MOS plug-ins which depend on NPAPI.

MOS (Media Object Server) is an XML based communications protocol often used with
newsroom production systems such as closed-caption generators and teleprompters. MOS plug-
ins create a bridge between production systems and popular newsroom management systems
like Avid INEWS, adding functionality and streamlined workflows.

MediaCentral UX Desktop is a client application incorporating an embedded version of Chrome
v43 capable of replacing a traditional web browser as an access portal for MediaCentral UX
users. This application allows clients that rely on MOS plug-ins for MediaCentral UX / iNEWS
workflows to continue to operate as normal.

System Requirements
MediaCentral UX Desktop has minimal requirements and in most cases matches the
requirements for a web browser.
> Operating systems:
e  Microsoft Windows 7, 32 bit or 64 bit
e  Microsoft Windows 8.1, 32 bit or 64 bit
> Flash Player
e Adobe Flash Player v18 (NPAPI) or higher

> Network

The application uses the same network ports to connect to the MCS servers as a web
browser. For additional network port information, see Avid MediaCentral Platform
Services Security Architecture and Analysis on the Avid Knowledge Base.

> Screen Resolution

A minimum screen resolution of 1280x1024 is required. If the size of the application
window is smaller than 1280x1024, some Ul elements might not be displayed.


http://www.avid.com/US/search?q=&site=kbase&filter=0&subfilters
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Installing Adobe Flash Player

The client software requires Flash Player to enable playback of assets in the Media pane. Ensure
that you have the correct version of Flash Player and install or update if necessary.

1. Open the Windows Control Panel and select “Programs and Features”.

2. Verify your current version of Flash Player:

Organize ¥ Uninstall =
Name . Publisher Installed On Size Version &
[~ Adobe Acrobat X Adobe Systems 47172015 263 GB 10113
B ~dobe Flash Player 18 ActiveX Adobe Systems Incorporated 8/5/2015 171 MB 18.0.0.209
A Adobe Flash Player 18 NPAPI Adobe Systems Incorporated 8/5/2015 17.6 MB 18.0.0.209

i Adobe Help Manager Adobe Systems Incorporated 3/27/2015 4.0.244

As pictured above, multiple versions of Flash Player could be installed on your client.
MediaCentral UX Desktop requires the “NPAPI” version of Flash Player. If you do not have
this version installed, complete the remaining steps in this process to obtain the required
software.

3. Open the web browser of your choice and navigate to:

https://get.adobe.com/flashplayer/otherversions/

Adobe Flash Player
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Windows 7/Vista/XP/2008/2003 v
Step2
FP 18 for Firefox - NFAPI v

System requirements
If your operating system/browser combination is not displayed,
refer to the Archived Flash Player versions page.

4. Select the appropriate operating system from the first pull-down menu.

5. Select the option for “FP 18 for Firefox — NPAPI” from the second pull-down menu.

Note: Mozilla Firefox does not need to be installed on your client to install this version of
Flash Player.

6. Click the “Download Now” button and follow the prompts to complete the installation.


https://get.adobe.com/flashplayer/otherversions/
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Installing MediaCentral UX Desktop

The software can be installed locally on a single client or installed remotely on multiple clients
through Domain Group Policy. Review the information below and select the process that best
meets your installation requirements.

> Single Client Installation

> Domain Group Deployment

Single Client Installation

Installing the software on a single client is accomplished through a standard Windows-based
installer and a manual edit of a configuration file. The software installation and configuration
requires administrator-level access to the Windows client.

Installing the Client Software
1. Loginto the Windows client as a user with administrator-level access.

2. Download MediaCentral UX Desktop from the Avid Download Center:

https://www.avid.com/US/Account/Orientation?ReturnUrl=http://esd.avid.com/Login.aspx

3. Unzip the installer to a new folder.

4. Launch MediaCentral_UX_<version>_Win.exe and follow the prompts to install the
application.

Editing the Configuration File

The client application can connect to one or more MediaCentral Platform Services (MCS)
systems within your network through a local configuration file (config.txt) that defines MCS
system descriptions and hosts. While there is no limit to the number of systems that can be
added to the configuration file, it must contain at least one system for the application to
operate.

The following table lists the content of the configuration file:

Value Example Value Description
This is a “friendly” name of the MCS system. This name will
appear in the System pull-down menu within the user interface.

Description “WAVD Central” The description has no character limit. It can contain spaces and
other special characters. Two exceptions to this rule are the

equals sign “=" and the comma “,” which have special meaning
within the configuration file.

<host> is the IP address, hostname or FQDN of the MCS server or
cluster.

Host address http://<host>

1. Navigate to the location of the configuration file:
C:\ProgramData\Avid\MediaCentralUX
2. Open the config.txt file in a basic text-editing program such as Notepad.

If a configuration file does not exist, you can manually create one.


https://www.avid.com/US/Account/Orientation?ReturnUrl=http://esd.avid.com/Login.aspx

3.
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Enter MCS system descriptions and hosts in the file. If you have multiple MCS systems,
separate each with a comma. Each MCS system should be entered in the following format:

description=http://<host>
If you have multiple MCS systems, separate each with a comma.

The following is an example of a completed configuration file with three MCS systems
configured:

WAVD Central=http://wavd-mcs,New York
Office=http://192.168.45.17,London Office=http://lon-mcs.domain.com

Save and exit the file.

Note: If an error is found in the configuration file, it can be modified to resolve the issue.
Changes are immediately reflected upon the next launch of the application.

Domain Group Deployment

If your site includes multiple MediaCentral UX client systems, the software can be deployed
using Windows Domain Group Policy for faster and easier installation. The process is automated
through the use of a script provided by Avid with the software package. For more information
on deploying software through Group Policy, see the following link:
https://support.microsoft.com/en-us/kb/816102

Configuring the Installation Script
The group deployment installation consists of two steps. The first of these steps involves editing
an Avid-supplied configuration script.

1.
2.

Log into the Windows client as a user with administrator-level access.
Download MediaCentral UX Desktop from the Avid Download Center:

https://www.avid.com/US/Account/Orientation?ReturnUrl=http://esd.avid.com/Login.aspx

Unzip the installer to a new folder.
Open the “InstallMediaCentral.cmd” file in a basic text-editing program such as Notepad.

The script contains the following line which includes two values that require editing:

%ScriptDIR%\MediaCentral_UX_1.0.0_Win.exe /s /v''/qb
SERVERLIST=""""MCSERVER=http://news-mcs""""""'

Value Example Value Description
This is a “friendly” name of the MCS system. This name will
appear in the System pull-down menu within the user interface.

MCSERVER “WAVD Central” The description has no character limit. It can contain spaces and
other special characters. Two exceptions to this rule are the

equals sign “=" and the comma “,” which have special meaning
within the configuration file.

Where <news-mcs> is the IP address, hostname or FQDN of the

news-mcs http://<host>
p:// MCS server or cluster.

6. Once the changes are complete, save and exit the text editor.


https://support.microsoft.com/en-us/kb/816102
https://www.avid.com/US/Account/Orientation?ReturnUrl=http://esd.avid.com/Login.aspx
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Running the Installation Script

The installation script can be run directly from a folder in Windows Explorer or from a command
line tool such as cmd.exe. If the installation fails for any reason, the command window will
report the reason for the failure which could be missed if running the script directly from a

folder.

The script will perform the following actions:

>
>
>

Silently runs the installer (no user prompts)
Create the config.txt configuration file using the values defined in the script

Copy the configuration file to “C:\ProgramData\Avid\MediaCentralUX” on the client
system.

Note: If an error is found in the configuration file, it can be modified to resolve the issue.
Changes are immediately reflected upon the next launch of the application.

To Install from Command Line:

1.

Navigate to the location of the Windows command prompt software, cmd.exe:
C:\Windows\System32

Right-click on cmd.exe and select “Run as administrator”.

This ensures you have the correct level of access to install the application.

Drag the “InstallMediaCentral.cmd” installer script from the Windows folder to the
command window.

This will copy the correct path and filename to the command prompt.

Press Enter in the command window to begin the installation.

The silent installer for the application will appear and automatically close when done.
A successful installation should return the following text in the command window:
ScriptDIR= C:\Avid_lInstallers\

Returncode was 0O

Install complete.

Note: If errors occurred during the installation, the Returncode will specify the source of
the issue.

Once the installation is complete, close the command window.

To Install from Windows Explorer:

1.

Navigate to the folder containing the MediaCentral_UX_<version>_Win.exe installer
and edited script file.

Double-click the “InstallMediaCentral.cmd” script to begin the installation.

A command window will appear, followed by the silent installer for the application.
Once the installation is complete, the command window will close.
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Enabling MediaCentral MOS Plug-ins

MediaCentral provides support for MOS Active-X plug-ins. For example, Deko Select is a plug-in
for a newsroom computer system’s interface that allows a user, such as a reporter, to drag and
drop graphic templates directly into the story, as well as alter replaceable text or graphics in the
selected template. Other plug-ins are available through third-party manufacturers.

These plug-ins are specific to INEWS workflows, and they are available only in Rundown and
Story layouts.

Installing Plug-Ins

MediaCentral UX Desktop installs the supporting infrastructure needed for Active X controls and
not the plug-ins themselves. Users need to install the individual MOS plug-ins required for their
workflow. For procedures on how to install plug-ins, see the documentation for the plug-in.

After installation and configuration, plug-ins are listed at the bottom of the Panes menu.

Note: Users that have been using MOS plug-ins with MediaCentral UX in a web browser do
not need to reinstall the plug-ins.

Enabling MOS

To use MOS plug-ins, users need to enable a setting in MediaCentral UX:

1. Sign into MediaCentral UX as the user that requires access to MOS plug-ins.
2. Select Home > User Settings > MOS

General
i

INEWS
Interplay | Production

Messages & Sharing

|| Sequence

3. Select the checkbox for “MOS enabled.”
4. Click Apply.

Recording Voice-over Audio

If your workflow requires the ability to record voice-over audio through MediaCentral UX, you
must configure the Flash Player to allow this functionality. This will prevent Flash from asking
the user if they want to enable a microphone for the MediaCentral UX site.

Note: Due to an issue interacting with Flash settings within the desktop user interface, this
configuration is required for any sites that include voice-over audio in their workflow.

1. Open the Windows Control Panel and select “Flash Player (32-bit)”.



2. Select the “Camera and Mic” tab and click the “Camera and Microphone Settings by Site...”

button.

Flash Player Settings Manager

==

- Camera and Mic | Playback | Updates | Advanced

Camera and Microphone Settings
@ Ask me when a site wants to use the camera or microphone (recommended)

(7 Block 3l sites from using the camera and micraphone

| Camera and Microphone Settings by Site.. |

The settings on this page are not applicable to Google Chrome or
! Chromium based browsers (PPAPI).

Learn more about confiquring Flash Player with Chromium based browsers
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|

Camera and Microphone Settings by Site

Previously visited websites that have asked to use the camera or microphone are
listed below. You can allow or block the use of the camera and microphone by
specific sites. Remove a site to delete all settings and data for that site in Flash
Player.

Website Camera and Mic Access

192.168.100.50 Alow

‘When the selected site wants to use a camera or microphone:

Add. Remove

menu.

Click the Add button at the bottom of the window.

Enter the IP address of the MediaCentral system and select “Allow” from the pull-down

Click the Add button to add MediaCentral UX to the list of allowed sites.

If you have additional MediaCentral systems, continue adding them to the Flash Player

settings and click the Close button once complete.

Launching and Working with MediaCentral UX Desktop

The desktop application maintains the same feature set as the MediaCentral UX web browser
experience. However, the methods used to access the MCS servers are slightly different. This

section includes the following topics:

>

>
>
>

Launching the Application
Working with the Menu System
Accessing Additional MCS Systems
Selecting a Deep Link

Launching the Application
Once installed, the application can be found and launched from the following locations:

» Windows 7: Through the shortcut added to the Desktop or through the Start menu at All
Programs > Avid > MediaCentral UX.

>

Windows 8: Through the tile added to the Windows 8 Start Screen or through the

shortcut added to the Desktop.

Note: If you do not see the tile, click the arrow in the bottom-left corner of the Start
screen to reveal all installed applications.

Calendar

Internet Explorer

After launching the software, sign in to MediaCentral UX as you would in a web browser.




MediaCentral | UX Desktop Installation Guide

Working with the Menu System
The menu system includes the following features:

File
» Close — Closes the application. If you have unsaved work, you will be asked if you want
to save your progress before exiting.
View
> Reload - Equivalent to a refresh of a web browser. If you have unsaved work, the
system will ask you to verify that you want to reload the interface.

> Clear cache — Equivalent to clearing the cache in a web browser. If you believe you are
seeing incorrect or stale data, clearing the cache and reloading the window should
refresh the data.

Systems

> Lists other MCS systems within the organization. See Accessing Additional MCS
Systems for more detail on this feature.

Help

> About — Provides the version of MediaCentral UX Desktop. Click anywhere outside of
the About window to continue working.

Accessing Additional MCS Systems

Modern web browsers enable users to open multiple tabs, with each tab functioning as an
independent browser. MediaCentral UX Desktop replicates the functionality of multiple tabs
through the Systems menu. This menu is populated with one or more MCS systems by the
config.txt configuration file created during the installation process.

@ MediaCentral | UX Desktop

File View | Systems | Help

Mew York Office

London Office

Selecting one of the systems in this menu will open an additional MediaCentral UX Desktop
window, allowing the user to sign in and work with the assets of the other MCS system.

Note: The user needs valid user credentials on the additional MCS system to allow sign in.

Selecting a Deep Link

A deep link is a link to an asset on a remote MCS system that has been sent to a user through
the Messaging pane. Similar to the process for accessing additional MCS systems, selecting a
deep link will open an additional MediaCentral UX Desktop window.

Note: The user needs valid user credentials on the additional MCS system to allow sign in.
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Uninstalling MediaCentral UX Desktop

The client software can be removed through a few simple steps. However, the config.txt
configuration file is intentionally excluded from this process. Leaving the configuration file in
place enables administrators to upgrade to a new version of the application, without needing to
reconfigure the settings.

1. Loginto the Windows system as a user with administrator-level access.
2. Open the Windows Control Panel and select “Programs and Features”.
3. Right-click on Avid MediaCentral | UX and select Uninstall.
This uninstalls the software from your system, but leaves the configuration file intact.

4. (Optional) If you want to remove all traces of the application, navigate to
C:\ProgramData\Avid\ and delete the MediaCentralUX folder which contains the
configuration file.

Troubleshooting

The following section describes situations that a user may encounter while working with
MediaCentral UX Desktop.

Error Messages:
The following error messages could be encountered when working with the MediaCentral UX
Desktop application:

> “Error connecting to the MediaCentral server. Please contact your administrator.”
This error appears in the MediaCentral UX Desktop interface if any of the following are true:
e The configuration file is missing.
e The configuration file exists, but is empty.
e The selected MCS system is offline or unavailable.

Resolution: Create or edit the config.txt file if it is missing or empty. If the configuration file
is correct, ensure the MCS system you are connecting to is available.

> A JavaScript error occurred in the main process. Uncaught Exception: Cannot read property
‘indexOf’ of undefined”

This error appears after launching MediaCentral UX Desktop and relates to an error in the
configuration file.

Resolution: Edit the config.txt file. Verify that commas are only used to separate MCS
systems and not used anywhere else in the file (e.g. description value).

> A JavaScript error occurred in the main process. Uncaught Exception: Cannot read property
‘split’ of undefined”

This error appears after launching MediaCentral UX Desktop and relates to an error in the
configuration file.

Resolution: Edit the config.txt file. Verify that equals signs (=) are only used between the
description value and the host address value and not used anywhere else in the file.
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Clearing the Local Cache
If you believe you are seeing stale data or there is an issue with the user interface, clearing the
local cache files from the client could resolve the issue.

Note: Users should save all work prior to completing this process.

1. Select the View menu and select “Clear cache”.
This action will sign the user out of the application.
2. Sign back into MediaCentral UX.

Cache files are stored in the following location: C:\Users\user\AppData\Roaming\MediaCentralUX

10
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